Getting Started

1. Preface
   - P. 2

2. Installing the Machine
   - P. 4

3. Connecting to a Computer and Installing the Drivers
   - P. 12

4. Configuring and Connecting the Fax
   - P. 24

Read this guide first.
Please read this guide before operating this product. The remarks for important safety instructions are described in the Basic Operation Guide. After you finish reading this guide, store it in a safe place for future reference.
Checking the Supplied Accessories

Confirm that all the supplied accessories are contained in the box. If an item is missing or damaged, please contact the Canon Authorized Service Facilities or the Canon Customer Care Center.

User Software CD-ROM
The User Software CD-ROM contains the MF Drivers, MF Toolbox, various software, and e-Manual*1. Depending on the operating system you are using, some functions of the driver software included in the CD-ROM may not be usable. The newest software is posted on the Canon web site. Please verify the operating environment etc. and download the appropriate software if required.

MF Drivers
The MF Driver contains the Network Scan Utility*2 (to use to scan over a network) as well as printer, fax, and scanner drivers.

MF Toolbox
The MF Toolbox provides a group of commands for you, such as to open a scanned image in an application, send it as an e-mail attachment file, and store it on the hard disk.

Miscellaneous Software
The User Software CD-ROM contains Presto! PageManager. Install it from the [Custom Installation] option.

*1 See “Using the e-Manual” (P. 33).
*2 Windows XP/Vista/7/8 only.

About the LAN and USB cables
The machine does not come with a LAN cable, USB cable, or a hub. Have cables or a hub ready as necessary.

- Make sure that the USB cable you use has the following mark.
- Please use LAN Cable of Category 5 twisted pair cable or higher for support.
- When connecting the machine to a 100BASE-TX Ethernet network, all the devices on the LAN must be compatible with 100BASE-TX.
Included Documents

Printed Manuals

Getting Started
This manual describes the configuration and software installation.

Wireless LAN Setting Guide
This manual explains the wireless LAN setup procedures and troubleshooting during the setup.

Basic Operation Guide
This manual describes the basic use of the machine.

Manuals Included in the CD-ROM

e-Manual
This manual explains all the features of the machine, and is categorized by subject. For details about using the e-Manual, see “Using the e-Manual” (P. 33).

Displaying the e-Manual from the CD-ROM
• For Windows
  Insert the User Software CD-ROM in your computer, click [Manuals], and then click [e-Manual].
  If the User Software CD-ROM has been already inserted in your computer and [Manuals] is not displayed, remove the CD-ROM and insert it again.

• For Macintosh

MF Driver Installation Guide
This manual describes how to install the MF Drivers, MF Toolbox, and software included on the User Software CD-ROM.
Removing the Packing Materials

Remove all the packing materials, such as orange tape. Packing materials may change in form or placement, or may be added or removed without prior notice.

1. Do not remove the cap from the USB port.

4. Check!
   - Are all the packing materials removed?
   - Tape
   - Packing materials with tape

Proper Handling

- Hold here.
Establishing an Installation Site

Do not place the machine near the following:
- Alcohol, paint thinner, or other flammable substances ▶ If flammable substances come into contact with electrical parts inside the machine, this may result in a fire or electrical shock.
- Any medical equipment ▶ Radio wave emitted from this machine may interfere with medical equipment.
- Surfaces that are unstable, subject to excessive vibration, objects that could block the ventilation slot, dampness or dust, in direct sunlight or exposed to the elements, subject to high temperatures, open flames, and poor ventilation ▶ Installing the machine in locations with these characteristics may result in personal injury, fire, or electric shock.

Ozone from the Unit
Although ozone is generated from the machine during operation, it does not have any affect on the human body. However, if you intend to use the machine for long periods of time, ensure that the installation location is well ventilated for a comfortable working environment.
Preparing the Toner Cartridge

Supplied Toner Cartridges

- The average yield is 800 sheets for the included K (Black) toner cartridge, and the composite yield is 800 sheets for the included C (Cyan), M (Magenta), and Y (Yellow) toner cartridges.* The average yield of replacement toner cartridges differ from the supplied toner cartridges.
- To purchase replacement toner cartridges:
  - “About Replacement Toner Cartridges” in the e-Manual

*The average yield is based on “ISO/IEC 19798” when printing A4 size paper with the default printing density.
Serial Number of the Machine

Write down the serial number and purchase date on the back cover of the Basic Operation Guide enclosed in the package. You need this information when contacting your local authorized Canon dealer or Canon Customer Care Center.

The serial number is indicated on the rating label located on the back side of the machine (a character string of 3 letters and a 5-digit number).

Write down the information here (on the back cover of the Basic Operation Guide).
Loading Paper

1. Slide the side paper guides inward until they are aligned securely against the edges of the paper.

2. Press the lock release lever and spread the side paper guides a little wider than the width of the paper.

5. Set the paper under the hooks. Make sure that the paper stack does not exceed the load limit mark.

6. Slide the side paper guides inward until they are aligned securely against the edges of the paper.

Loading Paper Other than Letter Size

The procedure here is for loading Letter size paper. To load paper other than Letter size, such as Legal or Statement, see “Loading Paper Other than Letter Size” (P. 28) after finishing the initial settings.
3. Press the lock release lever and spread the front-center paper guide a little wider than the length of the paper.

4. Load paper so that its edge is aligned with the rear side of the paper drawer.

7. Press the lock release lever, and slide the front-center paper guide inward until it is aligned securely against the edges of the paper.

8. Load paper so that its edge is aligned with the rear side of the paper drawer.
Connecting the Power Cord

1. Make sure that the machine is turned OFF, and then connect the power cord.

2. Turn ON the machine.

   - Do not connect the USB cable. Connect the cable when installing the software.

5. Press <Next>.

8. Select whether or not to perform color correction.
   It is recommended to perform color correction to obtain optimum copy or printout results.

   - Do you want to correct the color for a more accurate reproduction of the original?
     - Yes: Perform color correction.
       “Performing Color Correction” (P. 30)
     - No: Proceed to the next step.
Connecting the Power Cord

3 Press [▲] or [▼] to highlight a language, and then press [OK].

4 Press [▲] or [▼] to highlight a region, and then press [OK].

6 Press [▲] or [▼] to highlight your time zone*, and then press [OK].

7 Enter the date and time, and then press <Apply>.

9 Select whether or not to connect using wireless LAN immediately.

• Press [◄] or [►] to move the cursor to the left and right.
• Press [▲] or [▼] to change the numeric value, or AM/PM.

The factory default settings for time display is set as 12-Hour.

• If you do not connect the machine to a computer, proceed to fax configuration (P. 24).

* The time zone setting indicates the time difference between your local time zone and Coordinated Universal Time (UTC). The correct time zone setting is required for Internet communications.
Connecting to the Computer

Check! Choosing the Method to Connect the Machine to the Computer

First, you need to decide on the method you would like to connect your machine to the computer. Choose from the following three options.

Connecting via a Wired LAN
You can connect the machine to the computer through a wired router. Use the LAN cables to connect the machine to the wired router.

- Make sure that there is an available port in the router to connect the machine and the computer.
- Have a LAN Cable of Category 5 twisted-pair cable or higher ready.

Connecting via a USB
You can connect the machine to the computer using a USB cable.

Connecting via a Wireless LAN
You can connect the machine to the computer through a wireless router*. Since it is connected wirelessly, no LAN cables are needed.

* A wireless router which supports IEEE 802.11b/g/n is required.

NOTE
You can find a video and written guides which will ensure a smooth setup of the machine into your existing wireless environment at: www.usa.canon.com/WirelessHelp.

If you are not sure whether your router is wired or wireless:
See the instruction manual provided with your network device, or contact the manufacturer.
Connecting to the Computer

1 Wired LAN Connection

Check the following first. Windows

1 Are the computer and the router properly connected using a LAN cable?
For details, see the instruction manual provided with your network device, or contact the manufacturer.

2 Has the network settings on the computer been complete?
If the computer is not properly configured, you may not use the wired LAN connection even after completing the following settings.

NOTE
• You cannot connect both the wired LAN and wireless LAN at the same time.
• When you connect to a network environment that is not security protected, your personal information could be disclosed to third parties. Please use caution.
• If you connect through a LAN in the office, contact your network administrator.

2 Wired LAN Connection

Connect the LAN cable. Windows

The machine does not come with a LAN cable, router, or a hub. Have LAN Cable of Category 5 twisted pair cable or higher ready.

If the IP address on this machine has been changed:
If the machine is on the same subnet as the computer, the connection is maintained.

* If you want to manually configure the IP address:
If you have set a static IP address to the IP address of the computer, manually configure a static IP Address.

- “Setting IPv4 Address” in the e-Manual
- “Setting IPv6 Address” in the e-Manual

Wait for approximately 2 minutes.
The IP address will be automatically configured.*
Connecting to the Computer

3 Wired LAN Connection

Install the software. Windows

Install the MF Drivers and the MF Toolbox. Make sure that the machine is turned ON, and log on to Windows as a user with administrative privileges. Shut down all applications that are running. See MF Driver Installation Guide for details about installation.

NOTE

- If you are operating in the IPv6 environment, you may not install the software following the procedures below. See “Installing the MF Drivers on the WSD Network” in MF Driver Installation Guide.
- You may not use the scan function in the IPv6 environment.

1 User Software CD-ROM

- Click!

2 CD-ROM Setup

- Click!

Follow the instructions on the screen to continue.

4

- Select ✔

- Click!

- Take the CD-ROM out, if necessary.

Computer connection via the wired LAN is now complete.

Proceed to P.24 to configure the fax.

- Printer, fax, scanner drivers and MF Toolbox will be installed.

If the screen is not correctly displayed:

- Windows XP/Server 2003
  [Start] Menu → [Run] → enter [D:\MInst.exe]* → [OK]
- Windows Vista/7/Server 2008
  [Start] Menu → [Search programs and files] (or [Start Search]) → enter [D:\MInst.exe]* → press the [Enter] key
- Windows 8/Server 2012
  Right-click the lower-left corner of the screen → select [Run] → enter [D:\MInst.exe]* → [OK]

* The CD-ROM drive name is indicated as “D:” in this manual.
1 Wired LAN Connection
Check the following first.

1 Are the computer and the router properly connected using a LAN cable?
For details, see the instruction manual provided with your network device, or contact the manufacturer.

2 Has the network settings on the computer been complete?
If the computer is not properly configured, you may not use the wired LAN connection even after completing the following settings.

NOTE
- You cannot connect both the wired LAN and wireless LAN at the same time.
- When you connect to a network environment that is not security protected, your personal information could be disclosed to third parties. Please use caution.
- If you connect through a LAN in the office, contact your network administrator.

2 Wired LAN Connection
Connect the LAN cable.

The machine does not come with a LAN cable, router, or a hub. Have LAN Cable of Category 5 twisted pair cable or higher ready.

If the IP address on this machine has been changed:
If the machine is on the same subnet as the computer, the connection is maintained.

* If you want to manually configure the IP address:
If you have set a static IP address to the IP address of the computer, manually configure a static IP Address.
- “Setting IPv4 Address” in the e-Manual
- “Setting IPv6 Address” in the e-Manual

Wait for approximately 2 minutes.
The IP address will be automatically configured.*
Connecting to the Computer

3 Wired LAN Connection
Install the software. Macintosh

Install the MF Drivers for Macintosh. It requires Mac OS X 10.5.8 version or later. The installation screen varies depending on the version of Mac OS X.

This operation is for Macintosh. If using Windows, see P. 14.

1 Insert the User Software CD-ROM and double-click the CD-ROM icon.

2 Double-click!

Follow the instructions on the screen to continue.

3 Type your password to allow installer to make changes.
   Name: Canon
   Password: ********
   Enter
   Click!

   • Depending on the system environment, the dialog box may not be displayed. In this case, proceed to next step.

4 Installing the drivers is now complete. Continued with registration operations on the desktop.

5 Click!
Connecting to the Computer

Wired LAN Connection

Install the software.
Install the MF Drivers for Macintosh. It requires Mac OS X 10.5.8 version or later. The installation screen varies depending on the version of Mac OS X.

1. Click!
2. Select
3. Select
4. Click!
5. Click!
6. Select

- If you are using Mac OS X 10.5.8, click [+], select [Canon MF8200] from the dialog box displayed, and then proceed to next step.

Select a printer name for which [Bonjour] is displayed in the [Kind] or [Connection] column.
If you are using Mac OS X 10.5.x, select the corresponding driver from [Print Using].

- An IP address is automatically configured by the Bonjour function. If there is not the Bonjour function or you want to set the IP address manually, see “Setting IPv4 Address” or “Setting IPv6 Address” in the e-Manual.

Connecting with the manual setting

Enter
Select
Select
Click!

Proceed to P. 18
Connecting to the Computer

Macintosh

If you are using Mac OS X 10.5.x, select [Select a driver to use] and the corresponding driver from [Print Using], and then click [Add].

Click!

Check that this machine is added.

Computer connection via the wired LAN is now complete.

Proceed to P. 24 to configure the fax.
Connecting to the Computer

1 USB Connection

Install the Software. Windows

Install the MF Drivers and the MF Toolbox. Make sure that the machine is turned ON, and log on to Windows as a user with administrative privileges. Shut down all applications that are running. See MF Driver Installation Guide for details about installation.

Do not connect the USB cable yet.

Connect the USB cable after installing the MF Drivers and the MF Toolbox.

If you already connected the USB cable:
Windows 7/8: ① Disconnect the USB cable from the computer, ② and then proceed to step ①.
Windows XP/Vista: ① If the dialog box on the right appears, disconnect the USB cable from the computer*, ② click [Cancel], ③ and then proceed to step ①.
① If the USB cable is disconnected and the dialog box disappears, proceed to step ①.

• Printer, fax, scanner drivers and MF Toolbox will be installed.
• Select [Custom Installation] to install Presto! PageManager and the e-Manual.

If the screen is not correctly displayed:
• Windows XP [Start] Menu → [Run] → enter [D:\MInst.exe]* → press the [Enter] key
• Windows 8 Right-click the lower-left corner of the screen → select [Run] → enter [D:\MInst.exe] → [OK]
① The CD-ROM drive name is indicated as "D:" in this manual.

Follow the instructions on the screen to continue.

• Remove the CD-ROM, if necessary.

Proceed to P. 20
Connecting to the Computer

2 USB Connection

Connect the USB cable. Windows

After installing the software, such as MF Driver, connect the USB cable. Make sure the software is installed first.

Computer connection via the USB is now complete.

Proceed to P. 24 to configure the fax.
Install the software. **Macintosh**

Install the MF Drivers for Macintosh. It requires Mac OS X 10.5.8 version or later. The installation screen varies depending on the version of Mac OS X.

This operation is for Macintosh. If using Windows, see P. 19

---

1. **USB Connection**

   **Install the software.**

   Do not connect the USB cable yet.

   Connect the USB cable after installing the MF Drivers and the MF Toolbox.

   If you already connected the USB cable:
   ① Disconnect the USB cable from the computer, ② and then proceed to step ①.

   ① Insert the User Software CD-ROM and double-click the CD-ROM icon.

   ② Double-click!

   Follow the instructions on the screen to continue.

   ③ Type your password to allow installer to make changes.

   Enter

   Click!

   • Depending on the system environment, the dialog box may not be displayed. In this case, proceed to next step.

   ④ Click!

   • Installing the drivers is now complete. Continued with registration operations on the desktop.
Connecting to the Computer

2 USB Connection
Connect the USB cable. Macintosh

After installing the software, such as MF Driver, connect the USB cable. Make sure the software is installed first.

Computer connection via the USB is now complete.

Proceed to P. 24 to configure the fax.
Check! Selecting a Receive Mode That Fits Your Purpose

Choose your purpose to know the receive mode* to use. Remember the receive mode to configure the setting in “Selecting the Fax Receive Mode” (P. 26).

* If you have subscribed to a Distinctive Ring Pattern Detection (DRPD) service provided by your telephone company, <DRPD> is also available for the receiving mode. See the e-Manual for details about other receive mode.

Use for Fax Only/No Voice Calls
You can use only for fax and may not use for voice calls. You do not need to connect the external telephone.

Fax

Receive Mode ⇒ Auto

Mainly Use for Voice Calls/Almost Not Use for Fax
Connect an external phone to receive calls. Press the start button to receive faxes.

Phone

Receive Mode ⇒ Manual

Use for Fax and Voice Call

1 Using an answering machine
Connect an external answering machine to record voice messages when you are out, as well as receive calls. Faxes will be automatically received.

Phone Fax

Receive Mode ⇒ Answering Machine

2 Using a General Telephone
Connect the external telephone. Faxes will be automatically received and the machine will ring when voice calls come in.

Receive Mode ⇒ Fax/Tel Auto Switch
Set Up 1  Registering the Fax Number and Unit Name

When do you want to perform fax setup?
Set Up Now
Set Up Later

- If you select <Set Up Later>, the receive mode will be set to <Auto>.
- To reconfigure the settings, press ← <Fax Settings> → <Fax Setup Guide>.

OK

Register the unit telephone number for this device.

- Enter the fax number using the numeric keys, and then press <Apply>.

Register Unit Telephone Number
\[ +1234567 \]

- Enter the unit name, and then press <Apply>.

“Entering Text” (P. 35)

Proceed to the next page

Registered information will be printed on the recipient’s paper.
The fax number and unit name registered here will be printed on the recipient’s paper as the sender information.
Configuring the Fax

Set Up 2  Selecting the Fax Receive Mode

Set the receive mode that you confirmed in “Selecting a Receive Mode That Fits Your Purpose” (P. 24).

- To set to Auto mode → <Yes> → [OK]
- To set to other receive modes → <No> → [OK]

- To set to Fax/Tel Auto Switch mode → <Yes> → [OK]
- To set to other receive modes → <No> → [OK]

- To set to Answering Machine mode → <Yes> → [OK]
- To set to Manual mode → <No> → [OK]

When connecting a telephone with fax functions:
Set the fax receive mode of the telephone to “manual.”

Other receiving mode:
If you have subscribed to a Distinctive Ring Pattern Detection (DRPD) service provided by your telephone company, <DRPD> is also available for the receiving mode. See the e-Manual for details about other receive mode.
Set Up 3 Connecting the Telephone Line

Do you want to end Fax Setup Guide?  
Press [▲] to select <Yes>.

Turn the main power OFF and ON to apply the settings.

Turn OFF the machine.

Wait for at least 10 seconds.

Turn ON the machine.
The machine will restart, and the telephone line type will be automatically set*.

* If the telephone line type is not automatically set: See the Basic Operation Guide to set manually.

“Fax” → “Change the Fax Settings” → “Changing Fax Sending Settings” in the Basic Operation Guide
To load paper other than Letter size, such as Legal or Statement, see “Loading Paper” (P. 8) and the following procedure to load paper and specify the paper size and type.

1. Pull out the paper drawer.
2. Slide the paper guides, and spread them a little wider than the actual paper width.
3. After loading paper, slide the side paper guides and the front-center paper guide inward until they are aligned securely against the edges of the paper.
4. Make sure that the paper stack does not exceed load limit mark.
5. Press the lock release lever and adjust the length of the paper drawer.
6. Set the Legal dust cover on the paper drawer.
Appendix 8

• Press [▲] or [▼] to highlight a paper size, and then press [OK].

5

• Press [▲] or [▼] to highlight <Paper Settings>, and then press [OK].

6

• Press [▲] or [▼] to highlight the paper drawer for which you want to set the paper size and type, and then press [OK].

7

• Press [▲] or [▼] to highlight a paper size, and then press [OK].

8

• Press [▲] or [▼] to highlight a paper type, and then press [OK].

Loading Envelopes or Paper with a Letterhead

“Loading Envelopes or Paper with a Letterhead” in the Basic Operation Guide
Performing Color Correction

It is recommended to perform color correction to obtain optimum copy or printout results.

1. Do you want to correct the color for a more accurate reproduction of the original?
   - Yes
   - No

   - When the above screen is displayed during initial settings, select [Yes] to perform color correction.

2. Allowed Paper:
   - Size: A4, LTR, 16K
   - Type: Plain-3, Recycled

   - Make sure that paper is loaded, and then press [OK].

3. Steps (Start: Press OK)
   1. Print Image for Adjustment
   2. Scan Image for Adjustment

   - Confirm the procedure for color correction, and then press [OK].
   - An adjustment image is printed.

4. Step 1
   - Printing Image for Adjustment...

   - Place Image 1 on the glass with the black side toward the back.

5. • Open the feeder, place the test chart on the platen glass with the print side face down, and then close the feeder.
   • Place the paper so that the black stripe is at the back side of the machine.
If <Correction failed.> appears:
• Is the paper loaded correctly?
  → Load plain or recycled paper of A4/Letter size in the paper drawer.
• Is the adjustment image placed on the platen glass correctly?
  → Place the adjustment image with the print side face down and the black stripe toward the back of the machine.
• Has a paper jam occurred?
  → Remove the jammed paper.
If you want to perform color correction again, press [ ], and then select the following settings in the following order.
<Adjustment/Maintenance> → <Auto Adjust Gradation> → <Adjust Copy Image>
Checking the IP Address

You can check the IP address of the machine. Use it when you need to enter the IP address during the configuration or registration.

1. Press \[▲\] or \[▼\] to highlight <Network Information>, and then press \[OK\].

2. Press \[▲\] or \[▼\] to highlight <IP Address>, and then press \[OK\].

3. Press \[▲\] or \[▼\] to highlight <IPv4>, and then press \[OK\].

4. Press \[▲\] or \[▼\] to highlight <IP Address>, and then press \[OK\].

5. The IP address is displayed. Press [Status Monitor] to close the screen.

Check if the Machine Is Connected to the Network Correctly

Start a Web of the computer that is connected to the network, enter [http://IP address of the machine], and then press [ENTER]. (Example: http://192.168.0.225/)

The screen below (Remote UI) should be displayed.*

* If the remote UI screen is not displayed, see the e-Manual.
Using the e-Manual

The e-Manual is an electronic manual document that is displayed on the computer. All features of the machine are categorized by subject, and you can quickly view the information you need by using its search function. Use the e-Manual as a reference.

Using the Online Help

Information, such as driver software information, is included in the online help. When using the driver software, you can immediately view the description of the features and the contents of the settings.

**Windows**

1. Select [File] → [Print] from the menu bar of an application.
2. Select the printer in [Select Printer] or [Name] in the [Print] dialog box.
3. Click [Preferences] or [Properties].
4. Click [Help].

**Macintosh**

1. Select [File] → [Print] from the menu bar in the application.
2. Select the printer in [Printer].
3. Change the content displayed in lower pane of the dialog to [Finishing], [Quality], [Special Features], etc.
4. Click [?].
Disclaimers
The information in this document is subject to change without notice. CANON INC. MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS MATERIAL, EITHER EXPRESS OR IMPLIED, EXCEPT AS PROVIDED HEREIN, INCLUDING WITHOUT LIMITATION, THEREOF, WARRANTIES AS TO MARKETABILITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OF USE OR NON-INFRINGEMENT. CANON INC. SHALL NOT BE LIABLE FOR ANY DIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY NATURE, OR LOSSES OR EXPENSES RESULTING FROM THE USE OF THIS MATERIAL.

Trademarks
Canon, the Canon logo, and Color imageCLASS are registered trademarks of Canon Inc. in the United States and may also be trademarks or registered trademarks in other countries.

Bonjour, Macintosh, Mac OS, and OS X are trademarks or registered trademarks of Apple Inc. in the U.S. and/or other countries.

Microsoft, Windows, Windows Vista and Windows Server are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

All other product and brand names are registered trademarks, trademarks or service marks of their respective owners.

Copyright
© CANON INC. 2013 All Rights Reserved
No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language or computer language in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, without the prior written permission of Canon Inc.
## Entering Text

During the setup or initial configuration, you may need to enter letters and numbers. Use [▲], [▼], [◀], [▶], numeric keys, [✱], [#], and [OK] to enter text.

### Numeric Key Entry Mode (See below on how to change the Entry mode)

<table>
<thead>
<tr>
<th>Numeric Key</th>
<th>Entry Mode (See below on how to change the Entry mode)</th>
</tr>
</thead>
</table>
| 1           | <A> @.:_/
| 2           | ABC abc
| 3           | DEF def
| 4           | GHI ghi
| 5           | JKL jkl
| 6           | MNO mno
| 7           | PQRS pQRS
| 8           | TUV tuv
| 9           | WXYZ wxyz
| 0           | (Not available)
| #           | (space) @.:_/
|             | (Not available) |

### Changing the Entry Mode

The machine supports three entry modes: <A> for uppercase, <a> for lowercase, and <12> for numbers. The default setting is <A>. Press <A/a/12> or [✱] to change the entry mode.

### Entering a Space

Move the cursor to the end of the text, and then press [▶].

### Deleting Characters

Press [✱] to delete characters. Press and hold [✱] to delete all characters.

### Moving the Cursor

Press [◀] or [▶] to move the cursor.
Contacting the Service Center

When you have a problem with your machine, refer to “Troubleshooting” in the Basic Operation Guide or the e-Manual first. If you cannot solve the problem after referring the manuals, contact the Canon Authorized Service Facilities or the Canon Customer Care Center.

Canon Customer Care Center

1-800-OK-CANON
(U.S.A./Canada)

U.S.A.
Monday through Friday
From 8:00 A.M. to 8:00 P.M. EST

Canada
Monday through Friday
From 9:00 A.M. to 8:00 P.M. EST
http://www.canon.ca/